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Введение 
 
Целью учебной дисциплины является формирование специалистов, умею-

щих обоснованно и результативно применять существующие и осваивать новые 
знания при проведении оптимизации несущих конструкций транспортно-техно-
логических комплексов средствами САПР. 

Задачами учебной дисциплины являются получение углубленных знаний 
работы в CAE-среде и овладение вычислительными алгоритмами оптимизации 
конструкций ТТМ. 

В результате освоения учебной дисциплины обучающийся: 
– познает: 

а) математические основы методов оптимизации; 
б) особенности реализации методов оптимизации в прикладном про-

граммном обеспечении; 
– научится: 

а) проводить оптимизацию параметров технической системы с учетом 
ограничений; 

б) использовать современное прикладное программное обеспечение 
для проведения параметрической и топологической оптимизации тех- 
нических систем; 

– овладеет: 
а) программным модулем Design Explorer для проведения условной и 

безусловной оптимизации параметров технической системы; 
б) методами оптимизации аналитических целевых функций с уче- 

том ограничений. 
Оптимизация – один из этапов процесса разработки, т. е. жизненного цикла 

продукции, а поэтому технологии оптимизации относят к средствам автоматизи-
рованного проектирования. Оптимизация конструкции требует её параметриза-
ции, дающей возможность рассматривать альтернативные конструкции, изменяя 
значения параметров. 

Например, при разработке цилиндрического сосуда для хранения газов под 
давлением параметрами были бы средний диаметр, толщина, высота и исполь-
зуемый материал. Различные наборы значений параметров будут давать разные 
сосуды. В зависимости от ситуации некоторые параметры могут не иметь сте-
пеней свободы из-за ограничений. Например, может быть только один мате-
риал, так что для оптимизации сосуда остались бы только средний диаметр, 
толщина и высота. Мерой качества сосуда может быть максимально допусти-
мое давление, поделенное на вес. Средний диаметр, толщина и высота будут ва-
рьируемыми параметрами конструкции. Можно попытаться найти оптимальное 
сочетание параметров, которое приведет к максимальному значению показателя 
качества. Показатель качества может быть выражен в виде функции параметров, 
если воспользоваться знаниями, полученными при изучении сопротивления ма-
териалов. Оптимизируемые параметры называются переменными оптимизации, 
а показатель качества, вычисляемый по этим переменным, – целевой функцией. 
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Очевидно, что переменные оптимизации и целевая функция выбираются кон-
структором в соответствии с тем, для чего предназначается его творение. 

Большинство задач оптимизации ставятся вместе с ограничениями, которые 
могут быть трех типов. Ограничения первого типа задают область определения 
переменных оптимизации. Эти ограничения легко выполнить, потребовав, чтобы 
в процессе поиска переменные не выходили за установленные рамки. Ограниче-
ния второго типа – равенства сокращают размерность пространства решений. 
Лучшим методом обработки этих ограничений является исключение перемен-
ных алгебраическим путем. Однако метод исключения переменных применим 
только до тех пор, пока уравнения ограничений допускают решение относи-
тельно независимых переменных. При наличии нескольких ограничений процесс 
исключения может стать достаточно громоздким. В некоторых случаях явное ре-
шение уравнений может оказаться невозможным. Альтернативой выступает ис-
пользование штрафных функций. 

К третьему типу относятся ограничения-неравенства. Стандартный подход 
к задачам оптимизации с такими ограничениями состоит в том, чтобы изменить 
целевую функцию для учета влияния этих ограничений. Целевая функция моди-
фицируется добавлением штрафной функции, увеличивающей ее на большую 
величину при нарушении ограничений. Идея всех методов штрафных функций 
проста: при нарушении ограничения к целевой функции добавляется бесконечно 
большое число, в противном случае (ограничение не нарушено) целевая функция 
остается прежней. 
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1 Подготовка средствами CAD геометрической модели  
для параметрической оптимизации 

 
Цель лабораторной работы № 1 – изучение возможностей геометрических 

редакторов для проведения параметрической оптимизации средствами ANSYS. 
 
В программном пакете ANSYS имеется два геометрических редактора. 

SpaceClaim – ведущее решение по прямому моделированию в трехмерном ре-
жиме, предназначенное для быстрого конструирования концепций и обработки 
геометрии. Онлайн-справка (F1), обучающие видео (F3), руководства и учебные 
материалы помогают в кратчайшие сроки научиться эффективно использовать 
SpaceClaim. Модуль Design Modeler интегрирован в платформу Workbench и ис-
пользуется в качестве основного инструмента как для создания параметризован-
ных геометрических моделей «с нуля», так и для редактирования импортирован-
ных CAD-моделей. 

В основе лежит принцип «параметрического моделирования на основании 
предыстории» (history-based parametric workflows), который предполагает созда-
ние геометрической модели путем описания последовательности преобразова-
ний геометрии. Процесс работы с геометрической моделью построен на исполь-
зовании объектно-ориентированных средств управления. Этапы работы с гео-
метрической моделью имеют структурное представление в виде дерева. Для каж-
дого объекта в дереве возможен доступ к заданию и редактированию его свойств. 

DesignModeler позволяет создавать геометрию различных типов: объем-
ные тела, поверхности (оболочки) и линейные тела. Модуль имеет эффектив-
ные инструменты параметризации моделей. Параметрические модели исполь-
зуются при решении задач оптимизации. Кроме того, DesignModeler предо-
ставляет широкий выбор инструментов для исправления дефектной геометрии 
и доработки модели. 

Прежде чем приступить к работе в одном из пакетов, ознакомьтесь с разде-
лом Начало работы и руководствами, доступными в онлайн-справке. 

Создадим в среде SpaceClaim объемную модель, представлен- 
ную на рисунке 1. 

Используя команды на закладках «Файл», «Конструкция» и «Деталь», со-
здайте эскиз детали, отображенный на рисунке 2. 

Используя команду «Вытянуть», строим объемный объект и далее достраи-
ваем отсутствующие элементы в соответствии с рабочим чертежом. В итоге по-
лучается объемная модель, представленная на рисунке 3. 

Для создания управляемых параметров, которые будут использованы на 
дальнейших этапах автоматизации, выполним следующую последователь-
ность действий. 

1 Создадим управляемые параметры на диаметры тела вращения дета- 
ли «Корпус» (рисунок 4). Для этого выделим поверхность, образующую внут-
реннее отверстие диаметром 10 мм, и активируем кнопку «+P» рядом со значе-
нием диаметра, как показано на рисунке 5. 
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Рисунок 1 – Чертеж детали «Корпус» 
 

 
 
Рисунок 2 – Эскиз детали 
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Рисунок 3 – Объемная часть тела вращения 
 

 
Рисунок 4 – Объемная деталь «Корпус» 

 
После активации создаются на закладке Groups именованные наборы вы-

бранных элементов Driving Dimension и определяется тип изменяемого пара-
метра, в данном случае – размер. Далее необходимо определить как параметры 
внутренние отверстия с диаметрами 32 и 42 мм. 

2 После определяем параметр толщины основания под крепление. Его раз-
мер составляет 15 мм. Если все выполнили правильно, то получится четыре име-
нованных набора параметров (три диаметра и один линейный размер). 

3 Далее необходимо создать проект в ANSYS Workbench и убедиться, что 
выбранные параметры отразились как глобальные по проекту. На рисунке 6 
представлен проект без параметров и с ними. 
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Рисунок 5 – Активация параметра на размере 
 

 

 

Рисунок 6 – Структура проекта в Workbench с определенными параметрами  
геометрической модели (справа) и без них (слева) 

 
После выполнения задания оформите отчет по лабораторной работе. Отчет 

по лабораторной работе № 1 должен содержать следующие атрибуты: 
 титульный лист; 
 цель лабораторной работы и задачи, решаемые в ходе её выполнения; 
 последовательность команд для определения управляемых параметров 

объемной детали «Корпус» в SpaceClaim; 
 ответы на контрольные вопросы. 
 
Контрольные вопросы 
 
1 Как создать управляемый параметр типа размер? 
2 Как   создать   группу   выделенных   объектов   и какие параметры  

можно настроить? 
3 Можно ли создать управляемый параметр при помощи скрипта? 
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2 Подготовка средствами Design Modeler геометрической  
модели для параметрической оптимизации 

 
Цель лабораторной работы № 2 – параметризация представления объемных 

геометрических объектов. 
 
В основе DesignModeler лежит принцип «параметрического моделирования 

на основании предыстории» (history-based parametric workflows), который пред-
полагает создание геометрической модели путем описания последовательности 
преобразований геометрии. Процесс работы с геометрической моделью по-
строен на использовании объектно-ориентированных средств управления. 
Этапы работы с геометрической моделью имеют структурное представление в 
виде дерева. Для каждого объекта в дереве возможен доступ к заданию и редак-
тированию его свойств. 

DesignModeler позволяет создавать геометрию различных типов: объемные 
тела, поверхности (оболочки) и линейные тела. Модуль имеет эффективные ин-
струменты параметризации моделей. Параметрические модели используются 
при решении задач оптимизации. Кроме того, DesignModeler предоставляет ши-
рокий выбор инструментов для исправления дефектной геометрии и доработки 
модели. Прежде чем приступить к работе в одном из пакетов, ознакомьтесь с 
разделом Начало работы и руководствами, доступными в онлайн-справке.  

Интерфейс программы представлен на рисунке 7. 
 

 
 
Рисунок 7 – Интерфейс программы DesignModeler 
 
Используя команды на закладках Sketching и Modelling, создайте геометрию 

детали с параметрами, представленными на рисунке 8. 



 

  

  

11 

 
 
Рисунок 8 – Параметры поперечного сечения детали  
 
Обратите внимание на настройки команды Extrude. Длина детали должна 

быть 2000 мм и тонкостенная конструкция с толщиной 5 мм. После выполнения 
команды Extrude получается одна «part» и одно «body». Напротив каждого пла-
нируемого к дальнейшему использованию параметра ставится метка «D» синего 
цвета. Таким образом, при правильном выполнении работы должна получиться 
тонкостенная прямоугольная труба с управляемыми параметрами с последую-
щей оптимизацией H1, V2, FD2. 

В программе используются три стандартных типа параметров: длина, угол 
или безразмерные. Параметр или присвоение, которое не имеет ни одного из вы-
шеуказанных типов, будет установлено в значение «Не определено» и выделено 
желтым цветом в таблице (рисунок 9). 

 

 
 
Рисунок 9 – Окно интерфейса Parameter Editor 
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Значения типа необходимы для правильного изменения единиц в сеансе 
DesignModeler. Невозможно изменить единицы измерения в существующем се-
ансе DesignModeler, если для каких-либо параметров установлено значение «Не 
определено». Следует вручную изменить Undefined на один из трех стандартных 
типов или, когда нажимаете кнопку «Проверить», автоматически устанавлива-
ется действительный тип, если выражение состоит из одного имени переменной. 

После выполнения задания оформите отчет по лабораторной работе. Отчет 
по лабораторной работе № 2 должен содержать следующие атрибуты: 

 титульный лист; 
 цель лабораторной работы и задачи, решаемые в ходе её выполнения; 
 описание параметров их типа; 
 описание последовательности действий при изменении типа параметра; 
 ответы на контрольные вопросы. 
 
Контрольные вопросы 
 
1 На каком принципе построено моделирование объемной параметрической 

модели в DesignModeler? 
2 Можно ли изменить тип параметра на «Не определён», который имеет 

присвоенный ранее тип «Длина»? 
 
 
3 Построение плана и проведение виртуального эксперимента             

средствами ANSYS Workbench 
 
Цель лабораторной работы № 3 – постановка виртуального эксперимента по 

оптимизации конструкции. 
 
Задачи, решаемые в ходе выполнения работы: 
– определение алгоритма работы и выбор инструментария Workbench; 
– постановка эксперимента по оптимизации объекта. 
DesignXplorer использует инструмент, называемый Design of Experiments 

(DOE), для определения точек проектирования с комбинациями параметров и 
для наиболее эффективного исследования пространства решений. Наиболее эф-
фективное решение использует наименьшее количество проектных точек. DOE 
работает лучше всего с менее чем 20 параметрами. 

DesignXplorer делает доступными несколько типов DOE, чтобы можно было 
выбрать тип, наиболее подходящий для данного проекта и целей. Доступные 
типы DOE включают в себя: 

– Central Composite Design (CCD); 
– Optimal Space-Filling Design; 
– Box-Behnken Design; 
– Custom; 
– Custom + Sampling; 
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– Sparse Grid Initialization; 
– Latin Hypercube Sampling Design. 
На рисунке 10 представлены примеры использования плана эксперимента 

(DOE) с применением разных методов. 
 

 
 
Рисунок 10 – План эксперимента, сгенерированный различными методами 
 
Прежде чем начать, подготовьте CAD-модель проекта и определите атри-

буты, для которых хотите провести оптимизацию. Также можно использовать 
следующую примерную задачу о конструкции тормозов автомобиля. На рисун- 
ке 11 представлены параметры модели автомобильного тормоза. 

После построения геометрия должна содержать три тела и две части. 
Задача оптимизации имеет следующие цели. 
1 Разработка тормозного диска для экстренного торможения с минималь-

ным объемом. 
2 Минимизация максимального напряжения в тормозном диске. 
3 Максимизация первой собственной частоты тормозного диска. 
4 Минимизация максимальной температуры в тормозном диске. 
В ходе исследования необходимо будет решить задачи, связанные с анали-

зом напряженно-деформированного состояния, модального и теплового  
анализа конструкций. 

Анализ напряженно-деформированного состояния конструкции: тор-
мозной диск должен выдерживать давление тормозных колодок с гидравличе-
ским приводом в условиях резкого торможения. Напряжения возникают из-за 
трения между тормозными колодками и диском. Диск также испытывает центро-
бежные силы тела из-за его вращения. Результирующие напряжения, создавае-
мые этими силами, могут привести к разрушению материала. Поэтому очень 
важно убедиться, что напряжения в диске сведены к минимуму. 

Модальный анализ: свободный модальный анализ выполняется, чтобы 
убедиться, что первая собственная частота диска выше частоты запуска двига-
теля. Это гарантирует, что диск не будет поврежден из-за резонанса. 

Термический анализ: торможение в автомобиле происходит из-за трения 
между тормозными колодками и диском ротора. Это приводит к образованию 
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теплового потока в диске, что влечет за собой увеличение его температуры и теп-
ловых напряжений. Условия экстренного торможения вызывают высокие темпе-
ратуры, которые повреждают контактные поверхности. Поэтому важно миними-
зировать температуру, чтобы предотвратить износ диска. 

 

 

 

 
Рисунок 11 – Конструктивные параметры автомобильного тормоза 
 
Определение материала: в схеме проекта нажмите Engineering Data, затем – 

нажмите Engineering Data Source-> General materials, в списке найдите Gray 
Cast Iron и нажмите кнопку Добавить (знак «плюс»). Знак с синей книгой по-
явится после того, как будет назначен этот материал объекту (рисунок 12). 

Загрузить геометрию: в Project Schematic нажмите Geometry, затем со-
здайте геометрию в DesignModeler или импортируйте файл agdb (находится на 
локальной сети. Уточнить у преподавателя курса). 

Сетка геометрии: в Project Schematic дважды щелкните по Model, чтобы 
открыть экран Mechanical. Чтобы настроить сетку: щелкните правой кнопкой 
мыши (рисунок 13) Mesh -> Method -> Select all тел и затем выберите Tetrahedrons 
в опции Method. 
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Далее щёлкните правой кнопкой мыши (рисунок 14) Mesh -> Sizing -> Вы-
берите внутренние грани тормозных колодок и установите размер элемен- 
та 3 мм. Это связано с тем, что подушка относительно тонкая и имеет более вы-
сокую концентрацию напряжений, чем в других местах. Поэтому более мелкая 
сетка даст более точный результат моделирования. 

 

 
 
Рисунок 12 – Интерфейс окна добавления /изменения свойств материалов 
 

 
 
Рисунок 13 – Изменение метода создания конечно-элементной сетки 
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Рисунок 14 – Задание размера конечно-элементной сетки 
Назначить материал: обратите внимание на две части под геометрией (ри-

сунок 15) в окне структуры. Это тормозной диск и тормозные колодки. 
Назначьте типы материалов, щелкнув по каждому элементу, и перейдите в окно 
«Сведения» под контуром, найдите «Материал» -> « Назначение», выберите 
«Серый чугун» для диска и «Конструкционная сталь» для площадок. 

Определение граничных условий: щелкните правой кнопкой мыши Static 
Structural -> Insert -> Rotational Velocity ->. Установите 250 рад/с на ось y тормоз-
ного диска (рисунок 16). 

Щелкните правой кнопкой мыши по «Соединения», создайте Revolute 
Joint. Настройте соединение, как показано на рисунке 17. В разделе «Подробно» 
выберите «Заземление» для «Тип соединения», затем – выделенный (синий) кру-
жок для «Область». 

 

 

 
Рисунок 15 – Задание материала сборочной единицы 
 

 
 
Рисунок 16 – Задание граничных условий 
 
Щелкните правой кнопкой мыши Static Structural -> Insert -> Pressure -> Вве-

дите значения (рисунок 18), как показано, выбрав грани внешней тормозной  
колодки (рисунок 19). Сделайте это для каждой наружной поверхности  
тормозной колодки. 

Нажмите Соединения-> Контакты в окне структуры и щелкните правой 



 

  

  

17 

кнопкой мыши, чтобы добавить Область контакта вручную. Установите фрик-
ционный контакт, как показано на рисунке 19. Сделайте это для обеих областей 
контакта между колодками и диском. 

 

 
 
Рисунок 17 – Задание граничных условий 
 

 
 
Рисунок 18 – Определение величины давления 
 
Щелкните правой кнопкой мыши Static Structural -> Insert -> Displacement -> Fix 

смещение по осям X и Z всех граней тормозных колодок (рисунок 20). 
Выберите желаемые выходные значения и решите, щелкнув правой кнопкой 

мыши на Solution и нажав Solve. Установите Эквивалентное напряжение фон-
Мизеса в качестве выходного параметра (рисунок 21 – параметр Р). 

Обратите внимание, что решение чувствительно к различным настройкам, 
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включая размер сетки, нелинейные и термические деформации выбранных мате-
риалов, а также учитывается ли большое отклонение. 

 

 
 
Рисунок 19 – Задание граничных условий (величины давления) 
 

 
 
Рисунок 20 – Задание граничных условий 
 
Модальная настройка. 
Перетащите окно Модальный анализ на поле Геометрия статической струк-

туры. Используйте те же настройки геометрии и сетки, которые обсуждались ранее. 
Щелкните правой кнопкой мыши по деталям тормозных колодок в Geomet- 

ry -> Click Suppress (нужна только собственная частота тормозного диска). 
Нажмите Настройки анализа и введите «Максимальное количество режимов для 
поиска» как 10 (рисунок 22). 
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Рисунок 21 – Задание параметра оптимизации 
 

 
 

Рисунок 22 – Настройка параметров анализа частот автомобильного диска 
 
Щелкните правой кнопкой мыши Решение -> Вставить -> Деформация -> 

Итого ->. Введите номер нужного режима. Первые шесть мод – это моды твер-
дого тела. Параметризуйте частоту моды семь, которая является первой модой 
деформации, как показано на рисунке 23. 

 

 
 

Рисунок 23 – Задание параметра оптимизации по частотному критерию 
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Тепловой анализ. 
Перетащите окно Transient Thermal на вкладку Geometry окна Static 

Structural. Те же настройки геометрии и сетки, что и анализа напряженно-дефор-
мированного состояния. Подавите геометрию тормозных колодок, как описано в 
Модальном модуле. 

Под Transient Thermal нажмите «Начальная температура» и установите зна-
чение 35C, как показано на рисунке 24. 

 

 
 

Рисунок 24 – Задание граничных условий 
 
Нажмите «Настройки анализа» и установите значения, как пока- 

зано на рисунке 25. 
 

 
 

Рисунок 25 – Задание условий анализа 
 
Щелкните правой кнопкой мыши Transient Thermal -> Insert -> Convec- 

tion -> Выберите все поверхности тормозного диска и установите значения, как 
показано на рисунке 26. 

 

 
 

Рисунок 26 – Задание условий анализа 
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Щелкните правой кнопкой мыши Transient Thermal -> Вставить -> Тепловой 
поток ->. Выберите грань, как показано, и введите значения в соответст- 
вии с рисунком 27. 

 

 
 
Рисунок 27 – Задание условий анализа 
  
Повторите это для граней на другой стороне тормозного диска, как пока- 

зано на рисунке 28. 
 

 
 

Рисунок 28 – Задание условий анализа 
 
Щелкните правой кнопкой мыши Solution -> Insert -> Thermal -> Tem-

perature, настройте параметры (рисунок 29) и решите. 
Перенос геометрии и модели через модули анализа. 
Предположим, что был выполнен статический структурный анализ. 

Можно использовать сетку, созданную из этого анализа, чтобы выполнить 
другой анализ, скажем, модальный. Следующие шаги показывают, как это де-
лается. Чтобы скопировать геометрию в другой анализ, выделите и удержи-
вайте модальный модуль. 

Перетащите на вкладку статического структурного модуля, как пока- 
зано на рисунке 30. 
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Рисунок 29 – Задание параметра оптимизации 
 

 
Рисунок 30 – Создание связного анализа на основе общих параметров 
 
Геометрия является общей. Обычно это выполняется, когда два разных ана-

лиза должны быть выполнены для одной и той же геометрии. Придется  
сделать сетку снова. 

Определите входные параметры. 
Входными параметрами являются проектные переменные. Чтобы настроить 

их, нажмите на вкладку Geometry статического структурного блока. Параметри-
зуйте наружный диаметр, внутренний диаметр и толщину тормозного 
диска. Нажмите на эскиз 1, как показано на рисунке 31. Выберите размеры в ка-
честве входных параметров, как показано на рисунке 31, установив флажок. 

 

 
Рисунок 31 – Определение параметров геометрии для оптимизации 
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Базовые знания для DOE и оптимизации. 
Сначала необходимо определить некоторые термины для проб- 

лемы проектирования. 
Параметры: они включают в себя все доступные «аспекты» для данной кон-

струкции, например, геометрию, топологию, материалы и усиление контроля. 
Переменные: это подмножество параметров проекта, которые вы хотите 

настроить (поэтому остальные параметры фиксируются во время проектирова-
ния). Набор всех возможных переменных параметров называется пространством 
проектирования. 

Цели: цель определяет качество конструкции. Обычно это некоторые ха-
рактеристики, которые интересны (безопасность автомобиля, стабильность кон-
троллера и т. д.). Во многих случаях имеется заинтересованность в разработке 
более чем одной цели. Однако, чтобы упростить задачу, обсуждение будет со-
средоточено на одной цели. 

Ограничения: это функции переменных проекта, которые определяют до-
пустимое пространство переменных. Например, конструкция моста должна 
иметь максимальное напряжение меньше, чем критическое напряжение (раз 
фактор безопасности). 

Важно!!! В ANSYS и некоторых других программах разница между пара-
метрами и переменными не различается. Поэтому, когда видим «параметры», 
это может означать «переменные». 

Оптимизация – это итеративный процесс поиска дизайна, который мак-
симизирует или минимизирует цель путем поиска в пространстве дизайна. Су-
ществуют две основные школы алгоритмов оптимизации: градиентные ме-
тоды полезны, когда цель различима (во многих задачах математического и 
машинного обучения). Они быстрые, но могут найти только локальные реше-
ния; безградиентные методы полезны, когда оценка цели (и ее градиента) яв-
ляется дорогостоящей или когда градиент является шумным. Ansys предлагает 
оба варианта. 

 

 
 

Рисунок 32 – Определение локального и глобального экстремума 
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DOE (план эксперимента). 
Многие проблемы технического проектирования имеют цели, которые оце-

ниваются с помощью дорогостоящих симуляций/экспериментов, например, ана-
лиза CFD. В таких случаях оценка каждой функции во время оптимизации зани-
мает много времени и, следовательно, может сделать оптимизацию неразреши-
мой. DOE – это набор методологий, которые определяют, какой проект оцени-
вать из потенциально большого пространства проектирования, чтобы можно 
было создать статистическую модель для прогнозирования объективных значе-
ний других конструкций с низкой неопределенностью в прогнозировании. С по-
мощью модели прогнозирования также можно определить чувствительность пе-
ременных, т.е. сильно ли меняется цель по отношению к каждой из перемен-
ных. DOE часто используется как часть алгоритма оптимизации без градиента. 

План экспериментов (DOE). 
DOE используется для эффективной выборки расчетного пространства 

(например, всех проектных параметров для тормозного диска), чтобы можно 
было построить статистическую модель для прогнозирования откликов (напри-
мер, максимальное напряжение или первая собственная частота, или максималь-
ная температура) данной конструкции. DOE полезен, когда можно выбрать 
только ограниченное количество точек (т.e. выполнить ограниченное количество 
симуляций). Основная идея DOE заключается в распределении выборки так, 
чтобы результирующая статистическая модель имела низкую неопределенность 
в оценке модели и, следовательно, высокую точность в прогнозировании. 

Шаг 1. Определите параметры и ответы. 
Чтобы выполнить DOE для данной модели, сначала определим список пе-

ременных и целей проектирования, которые интересны (в Ansys они называ-
ются входными и выходными параметрами). Для этого откройте окно «Схема 
проекта», которое должно выглядеть следующим образом (рисунок 33). 

 

 
 
Рисунок 33 – Определение параметров и ответов 
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Шаг 2. Выберите метод исследования конструкции. 
В окне Design Exploration найдите Response Surface. Это позволит выпол-

нить DOE с целью создания прогнозирующей модели, называемой поверхностью 
отклика. Перетащите вкладку «Поверхность отклика» из панели инструментов 
(рисунок 34) в любой пунктирный блок рядом с «Набором параметров». 

 

 
 
Рисунок 34 – Определение плана эксперимента 
 
Шаг 3. Выберите метод DOE. 
В то время как ANSYS предоставляет различные методы DOE, предлага-

ется сделать выбор в пользу латинского гиперкуба (LHS) и оптимальное запол-
нение пространства. Основным преимуществом данных методов является то, 
что количество выборок не зависит от количества параметров. Другой (более 
продвинутый) выбор – это разреженная сетка, которая первоначально отбирает 
только несколько точек и адаптивно добавляет новые точки отбора на основе по-
верхности отклика. Кригинг с автоматическим уточнением имеет аналогичный 
эффект. Обратите внимание, что не рекомендуется Central Composite Design 
(CCD), потому что во многих случаях цель не может быть аппроксимирована как 
квадратичная функция, а CCD требует большого количества выборок для отно-
сительно небольшого числа переменных. 

Нажмите на «Дизайн экспериментов» и выберите необходимый DOE и тип 
дизайна (рисунок 35). 

 

 
 

Рисунок 35 – Определение метода плана эксперимента 
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Если дважды щелкнуть по вкладке «Дизайн экспериментов», откроется но-
вое окно, где можно увидеть свои входные и выходные параметры. Можно уста-
новить нижнюю и верхнюю границы каждого входного параметра, нажав на этот 
параметр, как показано на рисунке 36. 

 

 
Рисунок 36 – Входные и выходные параметры DOE и границы параметра 
 
После установки границ входного параметра нажмите «Предварительный про-

смотр», чтобы увидеть список точек DOE в соответствии с настройками. Теперь 
нажмите «обновить». В зависимости от того, сколько образцов было запрошено, 
расчет DOE может закончиться через несколько часов или дней (рисунок 37). 

Примечание. Некоторые из образцов DOE могут быть не оценены успешно 
из-за значительного изменения геометрии. В примере тормозного диска, если 
внешний радиус диска изменяется так, чтобы он был меньше, чем внешний ра-
диус колодок, настройку фрикционного контакта необходимо будет сбросить 
вручную из-за изменения сетки. Когда это происходит, это может указывать на 
то, что некоторые из образцов, отобранных DOE, не имеют смысла, например, 
если тормозные колодки частично покрывают диск, в конце концов, не является 
хорошим дизайном. Также может случиться, что появится желание оценить дан-
ные проекты. Для этого сначала вручную исправьте проблемы, связанные с из-
менениями параметров, и запустите симуляцию (и) вручную. Затем можно загру-
зить текущие результаты DOE, добавить данные, полученные вручную, и загру-
зить таблицу данных в ANSYS. 



 

  

  

27 

 
 

Рисунок 37 – Матрица плана эксперимента 
 
После выполнения задания оформите отчет по лабораторной работе. Отчет 

по лабораторной работе № 3 должен содержать следующие атрибуты: 
 титульный лист; 
 цель лабораторной работы и задачи, решаемые в ходе её выполнения; 
 составленный план эксперимента (DOE); 
 ответы на контрольные вопросы. 
 
Контрольные вопросы 
 
1 Какие рекомендации существуют при выборе метода DOE? 
2 Как   назначить   параметры,   отвечающие   за   изменения   объема  

тормозного диска? 
 
 
4 Прямая оптимизация средствами ANSYS Workbench 
 
Цель лабораторной работы № 4 – выполнение настроек проведения прямой 

оптимизации средствами DesignXplorer. 
 
Задачи, решаемые в ходе выполнения работы: 
– определение алгоритма работы и выбор инструментария; 
– постановка эксперимента по оптимизации объекта. 
Для выполнения данной работы будем использовать результаты предыду-

щей лабораторной работы. Создайте в Workbench дополнительный блок анализа 
Direct Optimization в ранее созданной структуре проекта (рисунок 38).  
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Рисунок 38 – Схематичное представление структуры проекта 
 
Двойным щелчком мыши по строке Optimization перейдите в настройку 

свойств прямой оптимизации. Выбрав строку Optimization, можно изменить па-
раметры с программных на ручные и выбрать метод оптимизации. Далее на 
строке Objective and Constraints в таблице проекта можно путем добавления па-
раметров сформировать пространство решения и назначить целевую функцию, 
установив её тип (рисунок 39). 
 

 
 
Рисунок 39 – Формирование пространства решения  
 
После нажатия кнопки Update произойдет формирование DOE и его после-

довательное решение в соответствии с планом эксперимента. Важно понимать, 
что при неправильно установленной целевой функции, например, минимизация 
массы или напряжений в объекте, можно после исследования скорректировать 
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целевое значение и запустить на повторное исследование. При этом те резуль-
таты, которые не противоречат новому значению целевой функции пересчиты-
ваться не будут и будет проводиться исследование оставшегося пространства оп-
тимизации. Таким образом, можно без построения поверхности отклика, прово-
дить простейшие виды оптимизационного исследования. 

После выполнения задания оформите отчет по лабораторной работе. Отчет 
по лабораторной работе № 4 должен содержать следующие атрибуты: 

 титульный лист; 
 цель лабораторной работы и задачи, решаемые в ходе её выполнения; 
 построенную DOE и оптимальные сочетания параметров для выбранной 

целевой функции; 
 ответы на контрольные вопросы. 
 
Контрольные вопросы 
 
1 Как создать  исследование Direct Optimization в  структуре  сущест- 

вующего проекта? 
2 Можно ли настроить метод оптимизационного исследования Direct Opti-

mization вручную или он управляется программой в автоматическом режиме? 
 
 
5 Оптимизация на основе поверхности отклика средствами 

ANSYS Workbench 
 
Цель лабораторной работы № 5 – изучение инструмента «Поверх- 

ность отклика». 
 
Задачи, решаемые в ходе выполнения работы: 
– изучение инструмента «Поверхность отклика»; 
– построение поверхности отклика. 
Для выполнения данной работы будем использовать результаты лабо- 

раторной работы № 3.  
1 Создание поверхности отклика. 
Результаты DOE могут быть использованы для создания поверхности от-

клика для целей прогнозирования. ANSYS предоставляет следующий список ме-
тодов поверхности отклика. 

Стандартная поверхность отклика: этот метод использует полиномиаль-
ную поверхность для подгонки данных, что требует наименьшего количества 
вычислений как подгонки, так и прогнозирования. Однако эффективность пред-
сказания во многом зависит от выбора полиномиальных оснований. Используйте 
этот метод, когда имеется много данных и изменение цели происходит плавно. 

Кригинг: метод непараметрический, это означает, что прогноз будет зави-
сеть от всех существующих точек данных. Таким образом, метод может быть 
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медленным в прогнозировании, когда есть большой объем данных для размеще-
ния. Из-за вычисления парных расстояний между точками данных результат бу-
дет рассчитан нескоро, поэтому используйте этот метод с осторожностью. К пре-
имуществам метода можно отнести автоматически исследование всего простран-
ства решения. Используйте этот метод, когда данные сильно нелинейны и огра-
ничены, чтобы модель соответствовала результатам моделирования. 

Непараметрическая регрессия: метод использует регрессию опорных век-
торов. Это похоже на Кригинг в том, что прогноз зависит от текущих данных. Но 
вместо использования всех данных метод выбирает наиболее важные точки дан-
ных для выполнения прогнозирования. Таким образом, его стоимость вычисле-
ний для прогнозирования меньше, чем у Кригинга. Тем не менее его стоимость 
все еще высока. Используйте этот метод, когда данные сильно нелинейны и не 
нужно, чтобы модель соответствовала результатам моделирования. 

Нейронная сеть: нейронная сеть с прямой связью создает нелинейное 
отображение от входа (дизайн) к выходу (его объективное значение), которое 
имитирует дорогостоящее моделирование. Обучение медленное (и может приве-
сти к тому, что при каждой тренировке будет другая модель, даже если данные 
одинаковы), когда сеть глубокая, но прогнозирование предполагает только про-
стое матричное вычисление и быстрое. Используйте этот метод, если данные 
сильно нелинейны и их много. 

Разреженная сетка: этот метод идет с соответствующим методом DOE. Он 
похож на Кригинг в том, что решает очень нелинейные задачи. Это достигается 
путем адаптивной выборки в самых неопределенных областях проектного про-
странства и, таким образом, может уменьшить количество необходимых выбо-
рок. Используйте этот метод, когда цель очень нелинейная и не можете позво-
лить себе много симуляций. 

Чтобы создать поверхность отклика, нажмите на опцию «Поверхность от-
клика» в окне «Схема проекта» (рисунок 40). Откроется новое окно. Выберите 
необходимый тип поверхности отклика, а затем нажмите на кнопку «Обновить». 

 

 
Рисунок 40 – Структура проекта и блок «Поверхность отклика» 
 
Общие проблемы в DOE и поверхности отклика. 
Модель плохо сходится, что делать? Есть два способа улучшить качество 

сходимости: увеличить размер выборки в DOE и увеличить «сложность» поверх-
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ности отклика. Чтобы выполнить последнее, можно просто выбрать модель по-
линома высокого порядка или непараметрическую модель, такую как кри-
гинг и непараметрическая регрессия. 

Модель идеально подходит, это хорошо? Короткий ответ – нет. В то время 
как увеличение «сложности» снижает «training error», т. e. ошибку между моде-
лью и данными, используемыми для обучения модели, не рекомендуется исполь-
зовать этот метод для доведения достоверности соответствия до предела. На са-
мом деле, в непараметрических моделях всегда можно идеально уместить все 
точки данных (всегда можно соединить все точки вручную). Но сделав это, ско-
рее всего, подгоним модель, так что у нее на самом деле будет хуже прогнозиро-
вание, чем у модели с более высокой ошибкой обучения. Чтобы подвести итог 
теории, стоящей за этим, модель имеет лучшую производительность прогнози-
рования, когда ошибка обучения низкая, а сложность модели также низкая. 

Так как же определить, какая модель лучше? Обычной практикой явля-
ется использование контрольных точек. Идея состоит в том, чтобы отложить 
некоторые данные, которые собрали, и никогда не использовать их для обучения 
модели, а использовать их только для вычисления ошибки, которая называется 
ошибкой проверки. Обоснование заключается в том, что если модель может хо-
рошо соответствовать этим данным, не используя их для обучения, то она имеет 
хорошую предсказуемость. 

Чтобы выполнить проверку в Ansys, нажмите «Поверхность отклика», как 
показано на рисунке 41. Установите флажок «Создать точки проверки» и введите 
количество точек проверки. На самом деле не существует правила о том, сколько 
точек проверки должны использовать, но 1/4 или 1/3 от общего размера выборки 
практически разумны. 

 

 
 
Рисунок 41 – Назначение контрольных точек при работе с поверхностью отклика 
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Что если результат проверки будет плохим? Это обычно может про-
изойти, если размер выборки небольшой, базовый отклик сильно нелинейный, 
или выбор поверхности отклика слишком гибкий (например, Кригинг), что при-
водит к перегрузке. Чтобы решить данную проблему, можете увеличить размер 
выборки, попробовать другую модель. Обратите внимание, что в ANSYS можно 
включить точки верификации в качестве точек уточнения, что приведет к лучшей 
точности подгонки. Для этого щелкните правой кнопкой мыши пункт про-
верки. Затем необходимо увеличить количество точек проверки в настройке по-
верхности отклика перед обновлением поверхности отклика (или в противном 
случае все точки используются для подгонки поверхности отклика). 

Когда прекратить доработку? Если целью создания поверхности ответа яв-
ляется исключительно использование поверхности для прогнозирования ответов, 
то необходимо убедиться, что при достаточном количестве точек проверки ошибка 
в прогнозировании ограничена. Для этой цели ANSYS предоставляет трехзвездоч-
ный рейтинг на соответствие посадочной поверхности для точек проверки. 

Если целью является оптимизация, точная поверхность отклика не требу-
ется. Поэтому с относительно точной моделью поверхности можно перейти к оп-
тимизации. Поскольку оптимизация выполняется на основе поверхности от-
клика, а не истинного моделирования, может существовать несоответствие 
между предсказанным и истинным откликами. ANSYS сообщает оба числа для 
набора почти оптимальных решений, которые он находит. Если несоответствие 
является значительным, следует установить эти решения в качестве точек уточ-
нения поверхности отклика и снова провести оптимизацию на уточненной по-
верхности. Более разумный подход – алгоритм байесовской оптимизации. 

Анализ чувствительности. 
Построение поверхности отклика также позволяет проводить анализ чув-

ствительности, т.e. видеть, насколько объективно меняется при изменении каж-
дой переменной. Когда существует большое количество переменных, анализ 
чувствительности дает возможность определить наиболее важные переменные 
для проектирования и, таким образом, уменьшить вычислительные затра- 
ты на оптимизацию. 

Чтобы выполнить анализ чувствительности, перейдите на вкладку «Поверх-
ность отклика». Параметры для анализа чувствительности показаны на рисунке 42. 

На рисунке 43 «Локальная чувствительность/Local Sensitivity» показывает 
норму частных производных выбранной цели по выбранным переменным. 

На рисунке 44 «Кривые локальной чувствительности» показывают кривую 
отклика выбранной цели (ось Y) относительно выбранных переменных (ось X). 

Оптимизация.  
Редко бывает такой случай, когда хотим оптимизировать только один кри-

терий. В приведенном примере перечисляется ряд целей. Однако нахождение 
«утопического» дизайна, который одновременно оптимизирует все цели, недо-
стижимо в действительности. Это вызвано тем, что всегда существуют кон-
фликты среди целей. Существует два решения этого: можно установить одну из 
целей как цель в ANSYS и остальных как ограничения. Путем изменения огра-
ничений можно получить последовательность оптимальных решений. Этот 
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набор решений является Paretto Optimal. Но, помимо последовательности опти-
мальных решений, гораздо ценно получить границу области оптимальных реше-
ний, которая будет ограничивать пространство оптимальных решений, т. к. бу-
дете представлять, как конфликтующие цели будут количественно влиять  
на целевую функцию. 

 

 
 
Рисунок 42 – Параметры для анализа чувствительности поверхности отклика 
 

 
 
Рисунок 43 – Параметры Local Sensitivity 
 
ANSYS предоставляет следующий список алгоритмов оптимизации. 
Скрининг: выборка наилучших значений случайным образом из простран-

ства решений. Используйте этот метод как начальную версию решения, чтобы 
убедиться, что все настроено правильно. 

Многоцелевой генетический алгоритм (MOGA): одновременно находит 
оптимальные по Парето конструкции. Используйте этот алгоритм, когда есть не-
сколько целей. 

Нелинейное программирование квадратичным лагранжианом (NLPQL): 
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быстрый локальный поиск. Используйте его, когда есть только одна цель (но можно 
установить другие цели как ограничения), моделирование не занимает слишком 
много времени (в минутах), количество переменных мало (меньше 10). 

 

 
 
Рисунок 44 – Параметры Local Sensitivity Curves 
 
Последовательное квадратичное программирование со смешанными 

целыми числами (MISQP): аналогично NLPQL, но допускает целочисленные 
переменные. Обратите внимание, что добавление целочисленных переменных 
часто значительно увеличивает время вычислений. 

Адаптивная одноцелевая оптимизация (ASO): метод использует опти-
мальное заполнение пространства для DOE, Kriging в качестве поверхности от-
клика и MISQP для нахождения локальных оптимальных решений по поверхно-
сти отклика. Используйте, когда оценка цели/констант является дорогой и огра-
ничен бюджет/время для оптимизации. 

Адаптивная многоцелевая оптимизация (AMO): аналогично ASO, в ней 
используются Kriging и MOGA. 

 
Что нужно проверить во время анализа и оптимизации? 
 
Каковы проектные переменные, ограничения и цели? 
Каковы потенциальные компромиссы между целями? 
Переменные непрерывны? Или они дискретные/целые? 
Есть ли аналитические функции цели/ограничения? И они диф- 

ференцируемы? 
Исходя из выше приведенных ответов, какие методы опти- 

мизации вы выберете? 
 
После выполнения задания оформите отчет по лабораторной работе. Отчет 

по лабораторной работе № 5 должен содержать следующие атрибуты: 
 титульный лист; 
 цель лабораторной работы и задачи, решаемые в ходе её выполнения; 
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 построенную поверхность отклика для автомобильного тормозного 
диска или иного объекта оптимизации; 

 ответы на контрольные вопросы. 
 
Задание 
Сравните ваш оптимальный дизайн с исходным (например, посмотрите сле-

дующее сравнение конструкции тормозного диска на рисунке 45) и прокоммен-
тируйте, является ли оптимальный дизайн рациональным. 

 
 
Рисунок 45 – Вариант оптимизации тормозного диска с уменьшением объема на 35,2 % 
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6 Подготовка геометрической модели к проведению  
топологической оптимизации 

 
Цель лабораторной работы № 6 – изучение основ подготовки геометрии для 

проведения топологической оптимизации. 
 
Задачи, решаемые в ходе выполнения работы: 
– изучение  возможностей  Ansys Workbench  в части  топологичес- 

кой оптимизации; 
– выполнение оптимизации и разработка цифрового прототипа. 
Для решения задач оптимального проектирования конструктивных элемен-

тов того или иного узла, как правило, применяется программный комплекс, со-
стоящий из нескольких частей. Каждая часть, выполняющая собственные подза-
дачи, выделена в отдельный модуль. При этом управление проектом оптимиза-
ции может быть выполнено как в ручном режиме, так и через управляющую про-
грамму. Алгоритм взаимодействия в общем виде между программными моду-
лями представлен в соответствии с рисунком 46. 

 

 
 
Рисунок 46 – Структура взаимодействия между модулями в задаче оптимизации формы 

и размеров конструкции 
 
Программа передает управление в определенной последовательности каж-

дому модулю, контролирует потоки информации между модулями построения 
геометрической модели, расчета и оптимизации. Она содержит средства диало-
гового общения и графического отображения, позволяет задавать исходные дан-
ные, оптимизируемые параметры, целевую функцию и ограничения, с помощью 
визуализации дает возможность пользователю оценивать и оперативно вмеши-
ваться в процесс оптимизации. Процедура оптимизации на основании функций 
цели и ограничений, а также их градиентов модифицирует параметры в соответ-
ствии с заложенной стратегией поиска, обеспечивает выход из итерационного 
процесса при достижении оптимального решения. Благодаря модульной струк-
туре оптимизационной программы возможно применение различных процедур 
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оптимизации и программ расчета НДС. В качестве расчетного модуля можно ис-
пользовать различные методы, например, метод конечных элементов (МКЭ) или 
метод граничных элементов (МГЭ). Достаточно соблюдать правила обмена ин-
формацией между модулями через некоторый стандартный интерфейс в виде 
текстового файла. Параметризованная модель создается в виде текстового файла 
с набором параметрических команд. При выполнении этого командного файла 
производится: построение геометрической модели, построение конечно-эле-
ментной сетки, приложение нагрузок; расчет НДС; вывод результатов.  

Программа расчета при изменении параметров производит обновление гео-
метрической модели и расчет НДС измененной модели, по результатам которого 
формируется выходной отклик. Управляющая программа по полученному от-
клику осуществляет расчет функций цели и ограничений, которые передаются в 
процедуру оптимизации. Процедура оптимизации генерирует новые значения 
параметров. Управляющая программа модифицирует командный файл на основе 
измененных параметров, запускает расчет НДС, считывает результаты из файла 
и далее процесс повторяется до нахождения оптимума. 

Задача получения оптимального решения с помощью инструмента – топо-
логическая оптимизация требует подготовки исходных данных и проведения 
глубокого анализа работы конструкции в различных условиях. Как правило, ре-
альные конструкции работают в гораздо более сложных условиях, которые 
имеют не только один вид нагружения, а подвергаются комплексу нагрузок. По-
этому оптимизация не ограничивается выбором только одного режима нагруже-
ния, на практике для проведения топологической оптимизации несущей кон-
струкции машины создают комплексный режим для получения силового кар-
каса, на основании которого и создается первый цифровой прототип. 

Топологическая оптимизация. Основные шаги. 
1 Создайте геометрию балки средствами DesignModeler или SpaceClaim. По-

перечное сечение 50 × 50 мм. Длина 500 мм. 
2 Выполните статический анализ со следующими параметрами. Материал – 

легированная сталь, величина изгибающей нагрузки 100 Н. Размер конечного 
элемента 2 мм. Также на конструкцию действует ускорение свободного падения. 
Ограничение от шести степеней свободы приложено на торцевую поверхность, 
противоположную приложению усилия. Эквивалентные напряжения и результи-
рующие перемещения являются критериями для последующего анализа. 

3 Создайте в Workbench проект, представленный на рисунке 47. 
 

 
 
Рисунок 47 – Структура проекта топологической оптимизации 
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4 Выполните перерасчет статического анализа и задайте область ограниче-
ния (Exclusion Region) для топологической оптимизации, как представлено на 
рисунке 48, используя команду Geometry Selection в разделе Define by. Устано-
вите Response Constant с настройками, приведенными на рисунке 49. 

 

 
 
Рисунок 48 – Исключение поверхностей из топологического исследования 
 

 
 
Рисунок 49 – Настройки раздела Response Constrain 
 
5 Выполните топологическое исследование и оформите отчет по лаборатор-

ной работе. 
Важно!!! Перед тем как приступать к выполнению лабораторных ра- 

бот № 7 и 8, нужно понимать, что качество топологического исследования опре-
деляется системой граничных условий и размером конечного элемента. Поэтому 
старайтесь создавать конечно-элементную сетку в области конструкции, которая 
подлежит оптимизации с несколькими слоями.  
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После выполнения задания оформите отчет по лабораторной работе. Отчет 
по лабораторной работе № 6 должен содержать следующие атрибуты: 

 титульный лист; 
 цель лабораторной работы и задачи, решаемые в ходе её выполнения; 
 образец оптимизации объекта средствами топологической оптимиза- 

ции и настройки решателей. 
 
 
7 Топологическая оптимизация несущей системы ТТМ 
 
Цель лабораторной работы № 7 – самостоятельное выполнение топологиче-

ской оптимизации несущей системы транспортно-технологической машины. 
 
Задачи, решаемые в ходе выполнения работы: 
– составление расчетной схемы и определение нагрузок; 
– проведение оптимизации средствами Ansys. 
Данная лабораторная работа выполняется самостоятельно студентом в те-

чение 6 ч. Рекомендуется следующий алгоритм действий при использовании то-
пологической оптимизации несущей конструкции. 

1 Определите с преподавателем объект несущей конструкции. Желательно, 
чтобы объект был связан с темой магистерской диссертации. В противном случае 
можно взять за основу любую несущую конструкцию следующих объектов: ка-
рьерный самосвал, автосамосвал, полуприцеп для перевозки технологи- 
ческого транспорта. 

2 Определите нагрузки, действующие на систему в статическом режиме 
(объект покоится на ровной поверхности с грузом/без груза). 

3 Определите нагрузки на объект при наезде на единичное препятствие вы-
сотой 0,2R (R – радиус колеса). 

4 Составьте пространственную расчетную схему для пп. 2 и 3. 
5 Продумайте сочетание нагрузок для комплексного режима. Для комплекс-

ного режима отбираются максимальные значения нагрузок. 
6 Определите пространство оптимизации несущей системы объекта с уче-

том компоновочных ограничений (двигатель, кузов, трансмиссия, баки, радиа-
торы, дополнительное оборудование и т. п.). Пространство оптимизации обяза-
тельно должно предусматривать места для ограничений степеней свободы (за-
крепления) и приложения нагрузок. Выбор этих мест оказывает значительное 
влияние на получение силового каркаса. 

7 Создайте проект в Workbench и проведите топологическое исследование. 
8 Экспортируйте полученную конечно-элементную модель в SpaceClaim  

и доработайте прототип несущей конструкции ТТМ.  
После выполнения задания оформите отчет по лабораторной работе. Отчет 

по лабораторной работе № 7 должен содержать следующие атрибуты: 
 титульный лист; 
 цель лабораторной работы и задачи, решаемые в ходе её выполнения; 
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 начальное решение и решение, полученное при помощи топологической 
оптимизации. 

 
В качестве примера на рисунке 50 представлен результат топологической 

оптимизации рамы карьерного самосвала.  

 

Рисунок 50 – Результат топологической оптимизации рамы карьерного самосвала 
 
В результате использования алгоритма топологической оптимизации сни-

жение массы рамы карьерного самосвала составило около 2 т. 
 
 
8 Топологическая оптимизация грузовой платформы ТТМ 
 
Цель лабораторной работы № 8 – самостоятельное выполнение топологиче-

ской оптимизации грузовой платформы транспортно-технологической машины. 
 
Задачи, решаемые в ходе выполнения работы: 
– составление расчетной схемы и определение нагрузок; 
– проведение оптимизации средствами Ansys. 
Данная лабораторная работа выполняется самостоятельно студентом в те-

чение 8 ч. Рекомендуется следующий алгоритм действий при использовании то-
пологической оптимизации грузовой платформы ТТМ. 

1 Определите с преподавателем объект грузовой платформы ТТМ. Жела-
тельно, чтобы объект был связан с темой магистерской диссертации. В противном 
случае можно взять за основу любой кузов следующих объектов: карьерный само-
свал, автосамосвал, полуприцеп для перевозки технологического транспорта. 

2 Определите нагрузки, действующие на систему в статическом режиме 
(объект покоится на ровной поверхности с грузом/без груза). 

3 Определите нагрузки на объект при наезде на единичное препятствие вы-
сотой 0,2R (R – радиус колеса). 

4 Составьте пространственную расчетную схему для пп. 2 и 3. 
5 Продумайте сочетание нагрузок для комплексного режима. Для комплекс-

ного режима отбираются максимальные значения нагрузок. 
6 Определите пространство оптимизации несущей системы объекта с уче-

том компоновочных ограничений (двигатель, кузов, трансмиссия, баки, радиа-
торы, дополнительное оборудование и т. п.). Пространство оптимизации обяза-
тельно должно предусматривать места для ограничений степеней свободы  
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(закрепления) и приложения нагрузок. Выбор этих мест оказывает значительное 
влияние на получение силового каркаса. 

7 Создайте проект в Workbench и проведите топологическое исследование. 
8 Экспортируйте полученную конечно-элементную модель в SpaceClaim  

и доработайте прототип несущей конструкции ТТМ. 
В качестве примера на рисунке 51 представлен результат топологической 

оптимизации платформы карьерного самосвала. 
 

 
 
Рисунок 51 – Результат топологической оптимизации платформы карьерного самосвала 
 
После выполнения задания оформите отчет по лабораторной работе. Отчет 

по лабораторной работе № 8 должен содержать следующие атрибуты: 
 титульный лист; 
 цель лабораторной работы и задачи, решаемые в ходе её выполнения; 
 начальное решение и решение, полученное при помощи топологической 

оптимизации. 
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